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Nazywam się Jacek Golak

Pracuję w Zakładzie Teorii Układów Jądrowych Instytutu Fizyki UJ

Moja dziedzina to teoretyczna fizyka jądrowa

Numer pokoju: B-2-32  

e-mail: jacek.golak@uj.edu.pl

strona WWW: http://users.uj.edu.pl/~golak/zestawyNOF.html

Przedmiot Narzędzia Obliczeniowe Fizyki ma charakter pomocniczy. 

Ma ułatwić studiowanie fizyki - dziedziny wiedzy, w której matematyka odgrywa kluczową rolę.

Wykłady i ćwiczenia mają pomóc  w zrozumieniu analizy matematycznej, algebry z geometrią, 

mechaniki klasycznej i kwantowej. Omawiane narzędzia z pewnością przydadzą się także przy 

opracowaniu

wyników doświadczeń na pracowniach fizycznych.

Zasadnicza część wykładu dotyczy programu Mathematica®.

Czym jest Mathematica® ?
https://www.wolfram.com/mathematica/



        

  

Coverage

Symbolic Language, Numerics, Mathematical Computation, 

Algebraic Manipulation, Number Theory, Function Visualization, 

Data Manipulation & Analysis, Machine Learning, Data Visualization & Graphics, 

Strings & Text, Graphs & Networks, Images, Geometry, 

Sound & Video, Knowledge Representation & Natural Language, 

Time-Related Computation, Geographic Data & Computation, 

Scientific and Medical Data & Computation, Engineering Data & Computation, 

Financial Data & Computation, Social, Cultural & Linguistic Data, 

Notebook Documents & Presentations, User Interface Construction, 

System Operation & Setup, External Interfaces & Connections, 

Cloud & Deployment

                http://www.mathematica.pl
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“Program dla każdego!

Mathematica jest środowiskiem pracy, które pozwala na obliczenia od prostej arytmetyki po 

najbardziej zaawansowane obliczenia matematyki wyższej. Zakres procedur 

obliczeniowych pozwala na wykorzystywanie jej tak przez uczniów i studentów jak i pra-

cowników naukowych, stosujących w pracach badawczych zaawansowany aparat matem-

atyczny. ’’

Jak zdobyć licencję
http://www.fais.uj.edu.pl/dla-studentow/studia-z-mathematica

Wybrana literatura

LITERATURA DO WYKŁADU I ĆWICZEŃ

Wykład i ćwiczenia będą w dużej mierze oparte o program Mathematica. Ze względu na ograniczony 

czas, jestem w stanie jedynie zaproponować wprowadzenie w niektóre aspekty tego programu, 

szczególnie przydatne dla studentów  fizyki. Tym, którzy chcą lepiej poznać środowisko Mathemat-

ica polecam 

(a) “kanoniczny” podręcznik tego produktu:

Stephen Wolfram,

The Mathematica Book, Wolfram Media, wiele wydań

 

(b) zestaw poradników ze strony producenta programu

http://www.wolfram.com/mathematica/resources/

(c) Wspaniałym źródłem przykładów, jest 
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“WOLFRAM DEMONSTRATIONS PROJECT”, gdzie pokazane są zastosowania środowiska Mathemat-

ica w bardzo wielu dziedzinach wiedzy. Dla nas najważniejsze są te dotyczące fizyki.

http://demonstrations.wolfram.com/

(d) bardzo wiele materiałów dostępnych w internecie, skrypty do wykładów, porady dla początkują-

cych itp.

Nic nie zastąpi jednak praktyki
Przedstawiam notatnik (notebook), w którym pokazane są proste przykłady pracy z programem 

Mathematica.

Możliwa jest praca w tzw. linii komend, ale praca w notatniku jest znacznie bardziej wygodna i 

efektywna.

Kalkulator
Ta komórka, tak samo jak komórka powyżej, ma charakter tekstowy. Tworzymy ją, wybierając z 

menu u góry  

Format ⟶  Style ⟶ Text

Poniższe komórki służą do wpisywania poleceń. Są to tzw. input cells.

In[1]:= 2 + 2 (* wyrażenie jest liczone po jednoczesnym naciśnięciu Shift i Enter ! *)

Out[1]= 4

In[2]:= (* ...... *) (* W ten sposób zapisujemy komentarze,

które nie mają wpływu na przebieg obliczeń,

ale powinny być przydatne w zrozumieniu tego, co robimy ! *)

In[3]:= 1 / 17 + 5 / 37

Out[3]=

122

629

In[4]:= (1 / 9 - 2 * 5)  (-9 + 3 / 76)^4 (* a^n oznacza a do potęgi n *)

Out[4]= -
2969233664

1935668386089
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In[5]:= sina

Out[5]= sina

In[6]:= a

Out[6]= a

In[7]:=

co⋯
Cos[

sinus

Sin[2 + 2 - 17 / 3 + 12 * 4 * 9^ (1 / 3) / (2 -

pierwiastek kwadratowy

Sqrt[2])]]

(* tu pojawi się nie tylko potęgowanie, ale także znane funkcje matematyczne *)

Out[7]= CosSin
5

3
-
48 ×32/3

2 - 2


In[8]:=

⋯
N[

co⋯
Cos[

sinus

Sin[2 + 2 - 17 / 3 + 12 * 4 * 9^ (1 / 3) / (2 -

pierwiastek kwadratowy

Sqrt[2])]], 100]

(* wartość przybliżona z dokładnością to 100 miejsc znaczących *)

Out[8]= 0.7226235917366384772931388285850524980272195462298253333193371525169682873282455089
281418517161379825

In[9]:= 2^34 / 234

Out[9]=

8589934592

117

In[10]:= 2^45 / 789

Out[10]=

35184372088832

789

In[11]:=

przybliżenie numeryczne

N
35184372088832

789


Out[11]=

4.45936 ×1010

In[12]:= (* Mamy do dyspozycji stałe matematyczne *)

In[13]:=

pi

Pi (* liczba pi *)

Out[13]=

π

In[14]:=

⋯
N[

pi

Pi, 200] (* jesli chcemy poznac wartosc

numeryczna pi z niemal dowolna dokladnoscia *)

Out[14]=

3.1415926535897932384626433832795028841971693993751058209749445923078164062862089986
2803482534211706798214808651328230664709384460955058223172535940812848111745028410
27019385211055596446229489549303820
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In[15]:=

liczba Eulera

E (* podstawa logarytmu naturalnego *)

Out[15]=

ⅇ

In[16]:= (* Uwaga: nie mylić ⅇ z e !!! *)

In[17]:=

⋯
N[

liczba Eulera

E, 200] (* wartość numeryczna ⅇ z (bardzo) dużą dokładnością *)

Out[17]=

2.7182818284590452353602874713526624977572470936999595749669676277240766303535475945
7138217852516642742746639193200305992181741359662904357290033429526059563073813232
86279434907632338298807531952510190

In[18]:= 100 ! (* silnia *)

Out[18]=

93326215443944152681699238856266700490715968264381621468592963895217599993 
229915608941463976156518286253697920827223758251185210916864000000000000000 
000000000

In[19]:=

silnia

Factorial[100] (* to samo w innym zapisie *)

Out[19]=

93326215443944152681699238856266700490715968264381621468592963895217599993 
229915608941463976156518286253697920827223758251185210916864000000000000000 
000000000

In[20]:= (* Mathematica podaje DOKłADNY WYNIK, jeśli to tylko możliwe *)

BARDZO WAŻNE : uwaga na zapis wyrażeń z funkcjami !!!

In[21]:=

si⋯
Sin

pi

Pi  6 (* argument funkcji sinus w radianach ! *)

Out[21]=

1

2

In[22]:=

sinus

Sin30
stopień

Degree (* argument funkcji sinus w stopniach *)

Out[22]=

1

2

In[23]:=

co⋯
Cos

pi

Pi  4

Out[23]=

1

2
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In[24]:=

tangens

Tan[14] (* tangens *)

Out[24]=

Tan[14]

In[25]:=

⋯
N[

tangens

Tan[14]]

Out[25]=

7.24461

In[26]:=

cotangens

Cot[14] (* cotangens ! *)

Out[26]=

Cot[14]

In[27]:=

tangens

Tan[x] *

cotangens

Cot[x]

Out[27]=

1

In[28]:= (* Mathematica używa często funkcji secans i cosecans,

które w polskiej literaturze są rzadko spotykane *)

In[29]:=

secans

Sec[x] *

cosinus

Cos[x] (* secans

secans

Sec[x]= 1/

cosinus

Cos[x] *)

Out[29]=

1

In[30]:=

cose⋯
Csc[x] *

sinus

Sin[x] (* cosecans

cosecans

Csc[x]=1
sinus

Sin[x] *)

Out[30]=

1

In[31]:= a = (

pierwiastek k⋯
Sqrt[1 / 200] +

pierwiastek kwadr⋯
Sqrt[3 / 101])^5 

si⋯
Sin

pi

Pi  8

Out[31]=

3

101
+

1

10 2

5

Csc
π
8


In[32]:= (* przypisaliśmy zmiennej a pewna wartość

i możemy to wykorzystać w dalszych obliczeniach *)

In[33]:= b = 13 * a - 234 * a^6

Out[33]=

13
3

101
+

1

10 2

5

Csc
π
8
 - 234

3

101
+

1

10 2

30

Csc
π
8
6

Pamiętajmy: mała kropka, duża różnica!
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In[34]:=

sinus

Sin[2]

Out[34]=

Sin[2]

In[35]:=

sinus

Sin[2.]

Out[35]=

0.909297

Gra w kolory !!!  

In[36]:=

sinus

Sin[2, 5] (* kolor czerwony oznacza nieprawidłową komendę ! *)

Sin: Sin called with 2 arguments; 1 argument is expected.

Out[36]=

Sin[2, 5]

In[37]:= abece (* kolor niebieski oznacza niezdefiniowaną wcześniej wielkość ! *)

Out[37]=

abece

Podstawowa zasada: nazwy komend programuMathematica (N, Plot, ...) oraz wbu-

dowanych funkcji (sinus, cosinus, tangens, cotangens, ...) zaczynają się od dużych liter; ich 

argument (lub argumenty) są zawarte w nawiasach KWADRATOWYCH !

Mathematica zna różne funkcje specjalne i pozwala nimi swobodnie operować. 

BARDZO WAŻNE DLA FIZYKA !

In[38]:=

funkcja Gamma

Gamma[5] (* Funkcja gamma Eulera to uogólnienie silni. Zachodzi

funkcja Gamma

Gamma[n]= (n-1)! *)

Out[38]=

24

In[39]:=

funkcja Gamma

Gamma[5] ⩵ 4 ! (* To tylko sprawdzenie szczególnego przypadku *)

Out[39]=

True

In[40]:=

funkcja Gamma

Gamma[7 / 3]

Out[40]=

Gamma
7

3

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In[41]:=

⋯
N

funkcja Gamma

Gamma
7

3


Out[41]=

1.19064

In[42]:=

uprość pełniej

FullSimplify[

funkcja Gamma

Gamma[n] ⩵ (n - 1) !,

należy do

Element[n,

zbiór liczb całkowitych

Integers] && n > 0]

(* Teraz mamy sprawdzenie ogólnej zależności

dla dowolnej liczby całkowitej większej od zera *)

Out[42]=

True

In[43]:=

funkcja J Bessela

BesselJ[1, 3] (* regularna o skończonej wartości dla argumentu zero fukcja Bessela *)

Out[43]=

BesselJ[1, 3]

In[44]:=

⋯
N[

funkcja J Bessela

BesselJ[1, 3]]

Out[44]=

0.339059

In[45]:=

funkcja P Legendre'a

LegendreP[12, x] (* wielomian Legendre'a o numerze 12 *)

Out[45]=

231 - 18018 x2 + 225225 x4 - 1021020 x6 + 2078505 x8 - 1939938 x10 + 676039 x12

1024

In[46]:=

funkcja P Legendre'a

LegendreP[12, 3, x] (* stowarzyszone wielomiany Legendre'a,

które w ogólnym przypadku nie są wielomianami : *)

Out[46]=

-
15015

128
1 - x23/2 45 x - 1020 x3 + 5814 x5 - 11628 x7 + 7429 x9

In[47]:=

harmoniczna funkcja sferyczna Y

SphericalHarmonicY12, -10, theta, phi  (* Harmoniki sferyczne *)

Out[47]=

5 ⅇ-10 ⅈ phi 88179

π -1 + 23 Cos[theta]2 Sin[theta]10

2048

Uwaga na nazwy funkcji, które składają się z kilku słów (arcus sinus, arcus tangens, arcus 

tangens hiperboliczny, ...)
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In[48]:=

arcus sinus

ArcSin[1 / 2]

Out[48]= π
6

In[49]:= ?? Arc*

Out[49]=

System`

ArcCos ArcCoth ArcLength ArcSinDegrees ArcTanh

ArcCosDegrees ArcCsc ArcSec ArcSinDistribution

ArcCosh ArcCscDegrees ArcSecDegrees ArcSinh

ArcCot ArcCsch ArcSech ArcTan

ArcCotDegrees ArcCurvature ArcSin ArcTanDegrees

In[50]:=

arcus tangens

ArcTan[1]

Out[50]= π
4

In[51]:=

arcus tangens hiperboliczny

ArcTanh[99 / 100]

Out[51]=

ArcTanh
99

100


Dlatego najlepiej jest używać nazw zmiennych i nazw funkcji pisanych małymi literami. Nie 

radzę próbować instrukcji typu: 

C=123.7;

D=13*Pi;

E=-1;

I=5;
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Rysowanie wykresów 2D
In[52]:=

wy⋯
Plot

sinus

Sin[x] +

cosinus

Cos[4 * x], x, 0, 2 *

pi

Pi

Out[52]=

1 2 3 4 5 6

-1

1

2

In[53]:=

wykres

Plot[1 / (1 - x^2), {x, -3, 3}]

Out[53]=

-3 -2 -1 1 2 3

-4

-2

2

4
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In[54]:=

wykres

Plot[{x^3,

cosinus

Cos[x^4]}, {x, -2, 2}]

Out[54]=

-2 -1 1 2

-4

-2

2

4

In[55]:=

wykres

Plot[{x / 100,

funkcja J Bessela

BesselJ[10, x]}, {x, 5, 25}]

Out[55]=

10 15 20 25

-0.2

-0.1

0.1

0.2

0.3
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In[56]:=

wykres trójwymia⋯
Plot3D[x^2 - 4 *

sinus

Sin[y^2], {x, 0, 2}, {y, -1, 4}]

Out[56]=

Listy
In[57]:= (* Uporządkowany zbiór, w zasadzie dowolnych, elementów *)

In[58]:= 1, 2, 3, x,

sinus

Sin[p], {y, z}, "napis"

Out[58]=

{1, 2, 3, x, Sin[p], {y, z}, napis}

In[59]:= (* zmienna ma wartość, która jest listą *)

In[60]:= dziwnalista = 1, x,

sinus

Sin[beta], {p, q}, {11, 12, z}

Out[60]=

{1, x, Sin[beta], {p, q}, {11, 12, z}}

In[61]:= dziwnalista〚1〛 (* pierwszy element listy; koniecznie podwójne nawiasy ! *)

Out[61]=

1

In[62]:= (* to samo inaczej ... *)

In[63]:=

część

Part[dziwnalista, 1]

Out[63]=

1
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In[64]:= (* ... i jeszcze inaczej *)

In[65]:=

pierwszy

First[dziwnalista]

Out[65]=

1

In[66]:= dziwnalista〚2〛
Out[66]=

x

In[67]:= dziwnalista〚4〛 (* ten element listy sam jest listą ... *)

Out[67]=

{p, q}

In[68]:= dziwnalista〚4〛〚1〛 (* ... i można zapytać, jaki jest jego pierwszy element *)

Out[68]=

p

In[69]:= (* Elementy listy w odwrotnej kolejności *)

In[70]:= dziwnalistawstecz =

odwróć kolejność

Reverse[dziwnalista]

Out[70]=

{{11, 12, z}, {p, q}, Sin[beta], x, 1}

In[71]:= (* Listy można ze sobą łączyć *)

In[72]:= lista1 = {1, 4, 2, 5};

In[73]:= lista2 = {10, 4, 5, 7, 3, 11};

In[74]:= lista3 =

połącz

Join[lista1, lista2]

Out[74]=

{1, 4, 2, 5, 10, 4, 5, 7, 3, 11}

In[75]:= (* Proszę zwrócić uwagę na powtarzające się elementy !

Można je usunąć przy pomocy komendy

usuń kopie

DeleteDuplicates *)

In[76]:= lista4 =

usuń kopie

DeleteDuplicates[lista3]

Out[76]=

{1, 4, 2, 5, 10, 7, 3, 11}

In[77]:= (* Prosta komenda zlicza elementy listy *)

In[78]:=

długość

Length[lista4]

Out[78]=

8
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In[79]:= (* Jeszcze inne instrukcje sortują listę *)

In[80]:= lista5 =

sortuj

Sort[lista4]

Out[80]=

{1, 2, 3, 4, 5, 7, 10, 11}

In[81]:= lista6 =

sortuj odwrotnie

ReverseSort[lista5]

Out[81]=

{11, 10, 7, 5, 4, 3, 2, 1}

In[82]:= (* lista, której elementami są wykresy *)

In[83]:= 
wy⋯
Plot[

pierwiastek kwadratowy

Sqrt[x], {x, 0, 2}],

wy⋯
Plot

sinus

Sin[5 * x], x, 0,

pi

Pi,
wykres

Plot[x^2, {x, -2, 2}]

Out[83]=



0.5 1.0 1.5 2.0

0.2

0.4

0.6

0.8

1.0

1.2

1.4

,
0.5 1.0 1.5 2.0 2.5 3.0

-1.0

-0.5

0.5

1.0

,

-2 -1 1 2

1

2

3

4



Niektóre komendy z definicji dają listy

In[84]:=

tabela

Table[n^3, {n, 1, 7}]

Out[84]=

{1, 8, 27, 64, 125, 216, 343}

In[85]:= (* teraz dostaniemy listę rysunków *)

In[86]:=

tabela

Table[

wykres

Plot[x^n, {x, -2, 2}], {n, 3, 5, 1}]

Out[86]=


-2 -1 1 2

-5

5

,

-2 -1 1 2

5

10

15

,
-2 -1 1 2

-15

-10

-5

5

10

15



In[87]:= (* prosta lista kolejnych liczb naturalnych od 1 do 10 *)

In[88]:=

zakres

Range[10]

Out[88]=

{1, 2, 3, 4, 5, 6, 7, 8, 9, 10}
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In[89]:= (* lista liczb naturalnych od 2 do 10 *)

In[90]:=

zakres

Range[2, 10]

Out[90]=

{2, 3, 4, 5, 6, 7, 8, 9, 10}

In[91]:= (* lista liczb naturalnych od 2 do 10, ale z krokiem 5 *)

In[92]:=

zakres

Range[2, 10, 5]

Out[92]=

{2, 7}

In[93]:= ?

zakres

Range

Out[93]=

Symbol

Range[imax] generates the list {1, 2, …, imax}.

Range[imin, imax] generates the list {imin, …, imax}.

Range[imin, imax, di] uses step di.

In[94]:= ?? Range

Out[94]=

Symbol

Range[imax] generates the list {1, 2, …, imax}.

Range[imin, imax] generates the list {imin, …, imax}.

Range[imin, imax, di] uses step di.

Documentation Local » | Web »

Attributes {Listable, Protected}

Full Name System`Range

In[95]:=

zakres znaków

CharacterRange["A", "Z"]

Out[95]=

{A, B, C, D, E, F, G, H, I, J, K, L, M, N, O, P, Q, R, S, T, U, V, W, X, Y, Z}

In[96]:=

zakres znaków

CharacterRange["α", "ω"]

Out[96]=

{α, β, γ, δ, ε, ζ, η, θ, ι, κ, λ, μ, ν, ξ, ο, π, ρ, ς, σ, τ, υ, φ, χ, ψ, ω}

Dla list z liczbami mamy bardzo użyteczne komendy:

16 NOF_1.nb

http://reference.wolfram.com/language/ref/Range.html


In[97]:= l1 = {2, 4, 1, 17, -3, 8, 95, -34, 0}

Out[97]=

{2, 4, 1, 17, -3, 8, 95, -34, 0}

In[98]:=

długość

Length[l1]

Out[98]=

9

In[99]:=

oblicz sumę

Total[l1]

Out[99]=

90

In[100]:=

średnia arytmetyczna

Mean[l1]

Out[100]=

10

In[101]:=

maksimum

Max[l1]

Out[101]=

95

In[102]:=

minimum

Min[l1]

Out[102]=

-34

In[103]:=

(* Bardzo ważne: można zadziałać funkcją na CAłĄ LISTĘ ! *)

In[104]:=

l1^2

Out[104]=

{4, 16, 1, 289, 9, 64, 9025, 1156, 0}

In[105]:=

sinus

Sin[l1]

Out[105]=

{Sin[2], Sin[4], Sin[1], Sin[17], -Sin[3], Sin[8], Sin[95], -Sin[34], 0}

In[106]:=

⋯
N[

cosinus

Cos[l1]]

Out[106]=

{-0.416147, -0.653644, 0.540302, -0.275163, -0.989992, -0.1455, 0.730174, -0.84857, 1.}

Rozwiązania równań występują w postaci list ! Dopiero odpowiednia składnia pozwala na 
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"wyłuskanie" wyniku 

In[107]:=

sol =

rozwiąż równanie

Solve[x^2 ⩵ 4, x]

Out[107]=

{{x → -2}, {x → 2}}

In[108]:=

sol〚1〛
Out[108]=

{x → -2}

In[109]:=

sol〚2〛
Out[109]=

{x → 2}

In[110]:=

pełna forma

FullForm[sol]

Out[110]//FullForm=

List[List[Rule[x, -2]], List[Rule[x, 2]]]

In[111]:=

(* Jak wydostać wartość -2, by użyć ją na przykład w dalszych rachunkach ? *)

In[112]:=

sol〚1〛〚1〛〚2〛
Out[112]=

-2

In[113]:=

(* tego można już używać jak zwykłej wartości liczbowej i przypisać ją zmiennej *)

In[114]:=

x11 = sol〚1〛〚1〛〚2〛
Out[114]=

-2

In[115]:=

x12 = sol〚2〛〚1〛〚2〛
Out[115]=

2

In[116]:=

(* Inny sposob wykorzystuje ogólny zapis PODSTAWIENIA *)

In[117]:=

x21 = x /. sol〚1〛
Out[117]=

-2
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In[118]:=

x22 = x /. sol〚2〛
Out[118]=

2

In[119]:=

(* Podstawienie działa tak: *)

In[120]:=

(z + z^2) /. {z → 11}

Out[120]=

132

=, czy ==, czy może === ?
In[121]:=

q = 90; (* jeden znak "=" przypisanie zmiennej wartości *)

In[122]:=

1 / 2 ⩵
si⋯
Sin

pi

Pi  6 (* dwa znaki "=" sprawdzenie równości liczb lub wyrażeń *)

Out[122]=

True

In[123]:=

rozwiąż równanie

Solve[x^2 + 3 * x + 6 ⩵ 0, x] (* dwa znaki "=" konieczne przy równaniach *)

Out[123]=

x →
1

2
-3 - ⅈ 15 , x →

1

2
-3 + ⅈ 15 

In[124]:=

x =

tangens

Tan[c];

In[125]:=

y =

sinus

Sin[c] 
cosinus

Cos[c];

In[126]:=

x === y (* sprawdzenie identycznego znaczenia wyrażeń *)

Out[126]=

True

Uzyskiwanie pomocy
Wiele komend posiada opcje, niekiedy bardzo wiele opcji
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In[127]:=

wy⋯
Plot[

pierwiastek kwadrat⋯
Sqrt[x], {x, 0, 3},

oznaczenia osi

AxesLabel → {"x", "y"},

styl grafiki

PlotStyle →
zielony

Green]

Out[127]=

0.5 1.0 1.5 2.0 2.5 3.0
x

0.5

1.0

1.5

y

In[128]:=

opcje

Options[

wykres

Plot]

Out[128]=

AlignmentPoint → Center, AspectRatio →
1

GoldenRatio
, Axes → True,

AxesLabel → None, AxesOrigin → Automatic, AxesStyle → {}, Background → None,

BaselinePosition → Automatic, BaseStyle → {}, ClippingStyle → None,

ColorFunction → Automatic, ColorFunctionScaling → True, ColorOutput → Automatic,

ContentSelectable → Automatic, CoordinatesToolOptions → Automatic,

DisplayFunction ⧴ $DisplayFunction, Epilog → {}, Evaluated → Automatic,

EvaluationMonitor → None, Exclusions → Automatic, ExclusionsStyle → None,

Filling → None, FillingStyle → Automatic, FormatType ⧴ TraditionalForm,

Frame → False, FrameLabel → None, FrameStyle → {}, FrameTicks → Automatic,

FrameTicksStyle → {}, GridLines → None, GridLinesStyle → {}, ImageMargins → 0.,

ImagePadding → All, ImageSize → Automatic, ImageSizeRaw → Automatic,

LabelingSize → Automatic, LabelStyle → {}, MaxRecursion → Automatic, Mesh → None,

MeshFunctions → {#1 &}, MeshShading → None, MeshStyle → Automatic, Method → Automatic,

PerformanceGoal ⧴ $PerformanceGoal, PlotHighlighting → Automatic, PlotLabel → None,

PlotLabels → None, PlotLayout → Automatic, PlotLegends → None, PlotPoints → Automatic,

PlotRange → {Full, Automatic}, PlotRangeClipping → True, PlotRangePadding → Automatic,

PlotRegion → Automatic, PlotStyle → Automatic, PlotTheme ⧴ $PlotTheme,

PreserveImageOptions → Automatic, Prolog → {}, RegionFunction → (True &),

RotateLabel → True, ScalingFunctions → None, TargetUnits → Automatic,

Ticks → Automatic, TicksStyle → {}, WorkingPrecision → MachinePrecision
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In[129]:=

?

przybliżenie numeryczne

N

Out[129]=

Symbol

N[expr] gives the numerical value of expr.

N[expr, n] attempts to give a result with n-digit precision.

In[130]:=

(* krotka informacja o funkcji

wykres

Plot *)

?

wykres

Plot

Out[130]=

Symbol

Plot[f , {x, xmin, xmax}] generates a plot of f as a function of x from xmin to xmax.

Plot[{f1, f2, …}, {x, xmin, xmax}] plots several functions fi.

Plot[{…, w[fi], …}, …] plots fi with features defined by the symbolic wrapper w.

Plot[…, {x} ∈ reg ] takes the variable x to be in the geometric region reg .

In[131]:=

(* bardziej rozbudowana informacja o funkcji

wykres

Plot *)

?? Plot

Out[131]=

Symbol

Plot[f , {x, xmin, xmax}] generates a plot of f as a function of x from xmin to xmax.

Plot[{f1, f2, …}, {x, xmin, xmax}] plots several functions fi.

Plot[{…, w[fi], …}, …] plots fi with features defined by the symbolic wrapper w.

Plot[…, {x} ∈ reg ] takes the variable x to be in the geometric region reg .

Documentation Local » | Web »

Options AlignmentPoint → Center…(65 total)

Attributes {HoldAll, Protected, ReadProtected}

Full Name System`Plot

(* pomoc na temat wszystkich funkcji lub poleceń zaczynajacych sie od "

wykres

Plot"

niestety w wersji 14.1 już nie działa! Lepsze jest wrogiem dobrego ... *)

?

wykres

Plot *
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Nasze własne funkcje
Puszczamy wodze fantazji i definiujemy NOWĄ funkcję

In[132]:=

f[x_] :=

t⋯
Tan[

si⋯
Sin[

cosinus

Cos[x]]] (* to nie jest jedyny sposób, ale na razie wystarczy;

więcej informacji o tzw. natychmiastowej i opóźnionej

defincji funkcji można znaleźć na mojej stronie w notebooku

natychmiastowa_i_opozniona_definicja_funkcji.nb

*)

In[133]:=

wykres

Plotf[x], x, 0,

pi

Pi

Out[133]=

0.5 1.0 1.5 2.0 2.5 3.0

-1.0

-0.5

0.5

1.0

In[134]:=

f[1]

Out[134]=

Tan[Sin[Cos[1]]]

In[135]:=

przybliżenie numeryczne

N[f[1], 20]

Out[135]=

0.56514343133040975986

In[136]:=

(* Jeszcze jeden ważny przykład: funkcję można zdefiniować KAWAŁKAMI *)

In[137]:=

w[x_] :=

funkcja odcinkowa

Piecewise[{{x^2, x < 0}, {x, x ≥ 0}}] (* uwaga na składnię *)
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In[138]:=

wykres

Plot[w[x], {x, -2, 2}]

Out[138]=

-2 -1 1 2

1

2

3

4

In[139]:=

w[0]

Out[139]=

0

Zapis z ‘@’

In[140]:=

wyczyść wszystko

ClearAll[f, g, h];

In[141]:=

f@x

Out[141]=

f[Tan[c]]

In[142]:=

f@g@h@x

Out[142]=

f[g[h[Tan[c]]]]

Czyste funkcje (pure functions = anonymous functions) 

In[143]:=

2 # & (* ta czysta funkcja zwraca podwojoną wartość argumentu *)

Out[143]=

2 #1 &

In[144]:=

2 # &[5]

Out[144]=

10

In[145]:=

(* Może być aplikowana do listy *)
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In[146]:=

2 #  &[{2, 6}]

Out[146]=

{4, 12}

In[147]:=

(* i zapisana także w ten sposób *)

In[148]:=

funkcja

Functionx, 2 x

Out[148]=

Functionx, 2 x

In[149]:=

funkcja

Functionx, 2 x[r]

Out[149]=

2 r

In[150]:=

(* Nadajmy funkcji nazwę *)

In[151]:=

f1 =

funkcja

Functionx, 2 x;

In[152]:=

f1[r]

Out[152]=

2 r

In[153]:=

f1@r

Out[153]=

2 r

In[154]:=

(* Użyjmy funkcji

zastosuj do

Map *)

In[155]:=

zastosuj do

Map[f1, r] (* Tak jest NIEPOPRAWNIE *)

Out[155]=

r

In[156]:=

zastosuj do

Map[f1, {r}] (* Tak jest POPRAWNIE *)

Out[156]=

2 r
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In[157]:=

wyczyść wszystko

ClearAll[f1, a, b, c, d];

In[158]:=

zastosuj do

Map[f1, {a, b, c, d}]

Out[158]=

{f1[a], f1[b], f1[c], f1[d]}

In[159]:=

(* To samo inaczej *)

In[160]:=

f1 /@ {a, b, c, d}

Out[160]=

{f1[a], f1[b], f1[c], f1[d]}

In[161]:=

(* Teraz

zastosuj do

Map działa na listę list na poziomie 1 *)

In[162]:=

zastosuj do

Map[f1, {{a, b}, {c, d}}]

Out[162]=

{f1[{a, b}], f1[{c, d}]}

In[163]:=

(* Teraz

zastosuj do

Map działa na listę list na poziomie 2 *)

In[164]:=

zastosuj do

Map[f1, {{a, b}, {c, d}}, {2}]

Out[164]=

{{f1[a], f1[b]}, {f1[c], f1[d]}}

In[165]:=

f1@ {{a, b}, {c, d}}

Out[165]=

f1[{{a, b}, {c, d}}]

In[166]:=

f1 /@ {{a, b}, {c, d}}

Out[166]=

{f1[{a, b}], f1[{c, d}]}

In[167]:=

f1 @@ {{a, b}, {c, d}}

Out[167]=

f1[{a, b}, {c, d}]
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In[168]:=

f1 @@@ {{a, b}, {c, d}}

Out[168]=

{f1[a, b], f1[c, d]}

Operator %
In[169]:=

v = 24 * 5 / (6 !)

Out[169]=

1

6

In[170]:=

przybliżenie numeryczne

N[%] (* % zastępuje wynik poprzedniego obliczenia. Ponieważ obliczenia

w poszczególnych komórkach mogą być wykonywane w dowolnej kolejności,

% nie oznacza automatycznie wyniku z poprzedniej komórki ! *)

Out[170]=

0.166667

In[171]:=

w = % + 11

Out[171]=

11.1667

In[172]:=

t1 = %% * 6 (* %% teraz wykorzystujemy przedostatnio uzyskany wynik *)

Out[172]=

1.

In[173]:=

t2 = %%% * 6 (* a teraz jeszcze wcześniejszy *)

Out[173]=

1.

In[174]:=

(* wynik z komórki numer 126 *)

t3 = (%126) * 6

Out[174]=

6 True

In[175]:=

Nadawanie wartości zmiennym i ich 
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odwoływanie
W jednej komórce można podać wiele komend

In[176]:=

a1 = 23

a2 = 3

a3 = 7

Out[176]=

23

Out[177]=

3

Out[178]=

7

Jeśli nie chcemy widzieć outputu (na przykład przy prostych instrukcjach przypisania), 

wtedy dajemy średniki 

In[179]:=

b1 = 23; b2 = 3; b3 = 7; b4 = -9.0; b5 = 76; b6 = 0;

In[180]:=

wyczyść

Clearb1  ; (* wartość b1 stanie się z powrotem nieokreślona;

proszę zwrócić uwagę na zmianę koloru na niebieski ! *)

In[181]:=

b1

Out[181]=

b1

In[182]:=

b2 =.; (* to dziala tak samo. UWAGA na zmiane koloru nazwy b2 z czarnego na niebieski *)

In[183]:=

wyczyść

Clear[b3, b4, b5] (* to wyczyści trzy zmienne naraz *)

In[184]:=

(* poniższa instrukcja wyczyści WSZYSTKIE PRZYPISANE WARTOŚCI i DEFINICJE *)

In[185]:=

wyczyść wszystko

ClearAll["Global`*"]

In[186]:=

a1

Out[186]=

a1
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In[187]:=

f

Out[187]=

f

Inne 
In[188]:=

s1 =

sumowanie

Sum[n^2, {n, 1, 10}]

Out[188]=

385

In[189]:=

(* łatwo użyc opcji

wstaw

Insert →
wejście

Input from above i potem zmienić , by uzyskać ... *)

In[190]:=

s2 =

sumowanie

Sum[n^5, {n, 1, 10}]

Out[190]=

220825

In[191]:=

(* podobnie można wykorzystać output z poprzedniej komórki *)

In[192]:=

sumowanie

Sumii^3, ii, 1, n

Out[192]=

1

4
n2 (1 + n)2

In[193]:=

g[n_] :=
1

4
n2 (1 + n)2 (* użyłem opcji

wstaw

Insert → Output from above *)

In[194]:=

(*

wstaw

Insert → Picture → From file *)

In[195]:=

;
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In[196]:=

zmniejsz ostrość

Blur , 5

Out[196]=

In[197]:=

bird = ;

In[198]:=

negatyw

ColorNegate[

wykryj krawędzie

EdgeDetect[bird]]

Out[198]=

Jak unikać podstawowych błędów
(0) Notatnik zbudowany jest z komórek. Na początku warto zapisywać polecenia w odręb-

nych komórkach, bo łatwiej jest zlokalizować błędy ! Polecenia wprowadzamy przy pomocy 

SHIFT+ENTER 

(1) Nawiasy ( ) są używane wyłącznie dla zaznaczenia kolejności operacji. Nie należy używać

{ } oraz [ ] w wyrażeniach matematycznych !

(2) Polecenia programu Mathematica oraz wbudowane funkcje mają nazwy zaczynające się 

z dużej litery !

(3) Nawiasy kwadratowe są używane dla argumentów poleceń i funkcji !
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(4) Nawiasy { } są używane wyłącznie w listach !

(5) Przy definiowaniu własnych funkcji  (na razie) trzymać się wzoru: f[x_]:= x^5  

(6) Równania (i porównywania) wymagają dwóch znaków ==

Przypominam: należy zwracać uwagę na kolory !

Kolor czerwony oznacza zwykle błędną składnię !

Kolor niebieski zmiennej oznacza, że nie nadano jej żadnej wartości, co może mieć wpływ 

na dalsze obliczenia z wykorzystaniem tej zmiennej !
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